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USER MANUAL 

 
Revision 05 – v.144 

 INTRODUCTION 1.

Thea for Cinema4D is an integrated version of Thea Render inside Maxon Cinema4D application. With 
the use of Thea Material Lab, Material Libraries, Interactive Render and Instancing Support you are 
able to render your scene directly inside Cinema4D. With the Export to Thea Studio functionality you 
can also stage your scene inside Thea Studio application and benefit of the advanced tools present 
there. At this manual all the basic installation and getting started steps are explained, along with 
Thea plugin settings panels and options inside Cinema4D. 
For seeing the Getting Started video, find Material Libraries and Download links, please visit Thea for 
Cinema4D landing page at www.thearender.com/cinema4d 
 
Note: this manual is covering the plugin settings and options only, so for a deeper and more detailed 
explanation of Thea Render settings, materials, engines etc., you can refer to Thea Render User 
Manual. 
 

 APPLICATION PREREQUISITES 2.

While the plugin can be used as a standalone application there are still dependencies of the plugin 
from the main Thea Render application. These dependencies are typically the need to open Thea 
default material editor but also to be able to access Thea data folder (materials, rooms, sample data, 
etc.). 
This means that Thea Render should be already installed on your computer (it doesn't matter 
whether you have installed the 32-bit or 64-bit variant though). On MacOSX platform, make sure that 
you have also run Thea application at least once (after your drag & drop it typically to your 
Application folder) in order to complete the installation process. Note that the plugin will work on 
OSX 10.6 and above. 
Cinema4D version should be R12, R13, R14, R15 or R16. The plugin won't run in previous Cinema4D 
versions. Note that the plugin is incompatible with the developed Thea plugin for R11/R11.5, so it 
won't be possible to transfer your work between the plugins. 
 

 
 
 
 
 
 
 
 
 
 

http://www.thearender.com/cinema4d
http://www.thearender.com/versions/TheaRenderManual_v1.3.pdf
http://www.thearender.com/versions/TheaRenderManual_v1.3.pdf


 
 

 3 Copyright © Solid Iris Technologies 

 INSTALLATION 3.
 Windows 3.1

The plugin comes with an installer that helps you define the 
version of Cinema4D to which you want to install the plugin 
and also its directory. 
The installer guides you through all the necessary steps of 
installation. 

 
Figure 1: Installing Thea for 

Cinema4D on Windows 

 MacOSX 3.2

 
Figure 2: Thea Render menu 

available at Cinema4D Top Menu 
 
 

 
Figure 3: Thea Render menu is also 
available at  Cinema4D plugins list 

Thea for Cinema4d for MacOSX comes with a dmg file. Inside 
this dmg file you will find the Thea Render folder. Drag and 
drop this folder inside plugins folder of Cinema4D installation 
(or user preferences folder). Then, within this folder, you will 
find four separated zip folders; one for each Cinema4D version. 
Select the needed one, according to your version, and simply 
double click on it to be extracted. Plugin is ready for use just 
afterwards (rest unused files can be deleted). 
It is recommended to install also the corresponding version of 
Thea Render standalone as well.  
The next time that you will start Cinema4D, the plugin should 
be there, at the top menu (see Figure 2) and under the Plugins 
menu (see Figure 3). 

 Installing Material Library 3.3  

Additionally, you can download a material library that allows 
easier and more direct use of Thea materials (note that this 
library is platform independent). 
For installing the Materials library, you should simply extract 
the library to Cinema4D content browser user libraries. 
 
Tip 1: if you face problems to locate the correct folder where 
Cinema4d stores its material libraries (lib4d format) you can 
find the correct path by going to Cinema4D Edit > Preferences 
and see that path at the bottom. At this location, inside the 
“library” folder, you can find the “browser” folder where the 
Thea Library can be added.  

 
Figure 4: Thea Material Libraries 

inside Content Browser  
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Tip 2: if you have successfully installed Thea Materials library, 
you should be able to access it in the Cinema4D content 
browser (see Figure 4). With right click on one of the appearing 
materials you can select the Show in Explorer (for Windows) or 
Show in Finder (MacOSX) for seeing the installation directory of 
the library. 
You can now drag and drop the selected material on a 
Cinema4D model or your materials window. 

 
 

 LICENSING AND ACTIVATION 4.

To run the plugin in a no demo mode (meaning without 
resolution limitation and watermarks), you will need to activate 
your license. This is done by going to Plugins > Thea Render > 
License (see Figure 5). A new dialogue box opens to help you 
add your full name, email address and serial number for 
activating the plugin (see Figure 6). 
Do not forget to add also the Thea for Cinema4D plugin serial at 
the plugins tab (see Figure 7). Afterwards restart your 
application for the changes to be applied. 
For finding more details on licensing, please refer to Thea 
Render User Manual corresponding chapter. 

 
Figure 5: License Menu 

  
Figure 6: License Input Form window – Main tab 

 
Figure 7: License Input Form window - Plugins tab 

 

 GETTING STARTED – MAIN WINDOWS 5.

After installing correctly the plugin, you will be able to find its main options at the corresponding 
Thea Menu (as we have seen in Figure 2 and Figure 3), from where you can open the Darkroom and 
start an Interactive or a Production rendering. Thea Render can be also found at the Renderers list at 
the Render Settings window of Cinema4D. You can go to Render > Edit Render Settings (or press 
CTRL+B) and at the available Renderers list select Thea Render (see Figure 8). From this menu you 
can define the settings for Output, Save and Multi – Pass (in the same way as for the native renderer) 
and for Thea Render specifically. At the next paragraphs we will see the available options for both 
Plugins menu and Render Settings window. 
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Figure 8: Render Settings window 

 

 THEA PLUGIN MENU OPTIONS 6.

 
Figure 9: Plugin Menu 

options 

As we see in Figure 9 user can select to open Thea Darkroom for 
rendering interactively or normally inside Cinema4D, See the Network 
log window, Export the scene for opening it later at Thea Studio, 
Convert Cinema4d materials to the corresponding Thea ones, define 
the used CPU and GPU devices for Presto engines, check for existing 
plugin and resources Updates, activate Thea License, edit the main 
plugin Preferences and see some main information at About window. 
 

 Thea Darkroom 6.1

 
Figure 10: Thea Darkroom inside Cinema4D 

The Darkroom command opens a window 
that resembles Thea Darkroom, as we see it in 
Figure 10. Thea Darkroom consists of several 
menus which help you render and post 
process your rendered image (which appears 
in the middle of the window - Area C). 
At this window, you can render the current 
scene inside Cinema4D using the defined 
Thea engine or make an interactive render. 
 
At the next paragraphs all the available 
buttons and functionality are explained. 
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 File and Window Menus (Area A) 6.1.1

 
Figure 11: Save options 

 
Figure 12: Send to 

options 

On top left, on area A, we can see the menus 
File and Window. 
File menu: opens the submenus Save, which 
saves the rendered image in one of the 
available formats (see Figure 11), and the 
Send to menu, which opens the rendered 
image at Thea Studio Darkroom (Image Editor) 
or opens the Cinema4D scene at Thea Studio 
Viewport (Scene Editor) or opens the 
rendered image at Cinema4D Picture Viewer 
(see the available option in Figure 12). 
 

  
Figure 13: IR options 

 
IR: from this menu we can enable/disable some 
basic parameters for Interactive Rendering (see   
Figure 13). 
1x1, 2x2, 4x4 and 8x8 Start Block options define 
the size of the rendered image square blocks once 
Interactive Render starts. By increasing their 
pixels, these blocks are bigger but result in faster 
Interactive rendering. With the next option we 
can enable/disable Supersampling during 
Interactive Rendering. By enabling the 
Termination Criteria option, Interactive Rendering 
takes into account the Termination criteria we 
may have specified for Production Rendering, so it 
results in stopping rendering once any of these 
criteria are met. Final option at this drop down list 
is the Continuous with Material Changes option. 
Once is enabled, we can see the changes of the 
material properties real-time, meaning without 
mouse button release (dragging for example 
diffuse color bar allow us to see the changes 
interactively). If it is disabled, the changes are 
applied after mouse button release. 
 

 
 

 
Figure 14: Show Windows 

 
Window: from this menu as seen in  
, user is able to show/hide the Render View 
(Area C), the Interactive Info (devices details 
at the bottom of Area C), the Progress Toolbar 
(Area D) and the Display Controls (Area E). 
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 Render Settings and Tools (Area B) 6.1.2

At the right top of the Darkroom window user is able to select among Interactive or Production 
modes, select the render engine and find some useful tools. According to Interactive or Production 
mode selection, different options appear on this bar. 

 

6.1.2.1 Interactive Mode 

  
Figure 15: Render Settings and Tools for Interactive Mode 

When Interactive Render option is selected user is able to see the rendered image interactively 
updated inside Darkroom window.  The following options are now enabled: 

 
Figure 16: Start IR 

With this button you are able to start Interactive Render. 

 
Figure 17: Pause IR 

Pause button allows pausing the rendering. Upon clicking it a message box 
appears to inform you that rendering is paused and prompt you to press OK for 
continuing it.  

 
Figure 18: Stop IR 

Stop button helps you to stop completely the rendering.  

 
Figure 19: Select IR 

Engine 

This drop down list presents the available render engines that can be used for 
Interactive Rendering. You can simply click and select the one you prefer. 
 
Tip 1: for more details on render engines please refer to Thea Manual. 
Tip 2: for more settings of each render engine you can go to Render Settings 
window. 

 

 
Figure 20: Select IR 

Resolution 

At the next drop down list you can 
select among the available resolution 
presets for your Interactive Rendering.  
 
Custom value uses the resolution that 
is given at Render Settings window 
(see Figure 21) at Output, so any 
resolution values and ratio can be 
added there and Thea will use them 
respectively.  

 
Figure 21: Render Settings Custom 

Resolution 
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Figure 22: Pick 

Region 

Once Interactive Rendering starts you are able to use the Pick Region tool and 
select a region (click and drag to create a rectangle) upon the rendered image 
(Area C) and let this region to be rendered. You can select any additional region 
you need and see the regions history appearing at a drop down list as seen in 
Figure 23. By clicking on any region from the list you can see this one being 
rendered instead. “No region” option let the whole image being rendered while 
“Remove All” option clears the regions history. 
Tip: after stopping the rendering the list of regions selected is still active; you 
can double click on any region from the list and see the image being refreshed 
accordingly. 
 
Note: once the Pick Region Tool is enabled the button is highlighted with an 
orange color. 

 

 
Figure 23: Selected Region is being rendered and available Regions List can be 

seen 
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Figure 24: Pick 

Material 

With Pick Material you are able to select any material from the rendered image 
(simple click on it with the Pick material enabled – icon will be in orange color) 
and see its properties appear at the Cinema4D attributes panel. You can then 
make any changes to the material and see them being applied interactively. 
Note: as already mentioned, once the Pick Region Tool is enabled the button is 
highlighted with an orange color. 

 
Figure 25: Pick 

Focus 

Pick Focus tool helps you define the focus point of your scene so that your 
camera will focus to the desired point (camera needs to have appropriate f-
number to achieve nice depth of field effect). At the following example renders 
with the use of Pick Focus tool we have selected two different focus points by 
simply click on them. 
Note: once the Pick Region Tool is enabled the button is highlighted with an 
orange color. 

 

Figure 26: Selected Focus Point at the 
middle of the scene 

 

 
Figure 27: Selected Focus Point at the 

front of the scene 

 
Figure 28: 

Navigation Controls 

These three navigation controls, which appear on the top right side of the 
Darkroom, work in the same way as Cinema4D corresponding ones. 
Once mouse button is released Cinema4D Viewport is automatically updated to 
the new view. 
 

 

 
Left Click on this button + 

Drag pans the scene. 
Right Click + Drag  zooms 

in and out the scene. 

  
Left/Right Click on this 
button + Drag zooms in 

and out the scene. 

 
Left Click on this button + 

Drag rotates the scene.  
Right Click + Drag rolls the 

scene. 
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6.1.2.2 Production Mode 

 
Figure 29: Render Settings and Tools for Production Mode 

When Production Mode option is selected user is able to make a production (final rendering) that is 
not being refreshed upon scene staging. The following options appear at this bar: 

 
Figure 30: Start 

Render 

With this button you are able to start Production Render. 

 
Figure 31: Pause 

Render 

Pause button allows pausing the rendering. Upon clicking it a pause icon is 
appearing on the rendered image showing that the rendering is being paused. 
By pressing it again you can continue rendering it.  

 
Figure 32: Paused Render 

 
Figure 33: Stop 

Stop 

Stop button helps you to stop completely the rendering.  

 

 
Figure 34: Select 
Render Engine 

This drop down list presents the available render engines that can be used for 
Production Rendering. You can simply click and select the one you prefer before 
start rendering. 
By selecting a Progressive engine two additional options appear that help you 
define Termination Criteria: Time Limit and Samples per Pixel Limit (see Figure 
35). 
By clicking upon these icons you can enter the desired time and/or Samples per 
Pixel values (see Figure 36). The first criterion that will be met will prompt 
rendering to stop. 
Tip: 30s stands for 30 seconds, 30m for 30 minutes, 1h for 1 hour etc. 

 

  
Figure 35: Time and 
Samples/Pixel Limits 

 
Figure 36: Define Time and Samples/Pixel limits 
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Figure 37: Presets 

Option  

By selecting the Preset option a new menu appears 
showing the available render presets at a drop 
down list (see them in Figure 38). 
The name of each preset indicates the engine that 
will be used for rendering. For Adaptive BSD engine 
several presets exist for both exterior and interior 
scenes, with a variation to the final quality (from 
preview to fine).  
 
Note: Progressive (AO) and Progressive (MC) will 
not be directly available after edition 1.4.  
Due to the rise of Presto (AO) and Presto (MC), 
which is the analog of Progressive (AO) and 
Progressive (MC), these engines have been removed 
from the main engine selection list - for better 
clarity and less future maintenance work. One will 
still be able to use them through presets though. 

 
Figure 38: Available Presets 

List 

 
Figure 39: Select 

Render Resolution 

At the next drop down list you can 
select among the available resolution 
presets for your Production Render.  
 
Custom value uses the resolution that 
is given at Render Settings window 
(see Figure 40) at Output, so any 
resolution values and ratio can be 
added there and Thea will use them 
respectively.  

 
Figure 40: Render Settings Custom 

Resolution 

 
 
 

 Rendered Image and Interactive Info (Area C) 6.1.3

As we have already mentioned this area not only hosts the rendered image for both Interactive and 
Production rendering but is also active during Interactive Rendering, as user can perform the 
following actions: 

- Alt + Left Click + Drag is used for rotating the scene. 
- Alt + Right Click + Drag is used as Dolly (zooming in out the selected point). 
- Alt + Mouse wheel scrolling zooms in and out the scene. 
- Alt + Middle click +Drag is used for panning. 
- As mentioned already with the Pick tools user can select regions (by clicking and dragging 

for defining the region) and select materials and focus points (by clicking once on the 
rendered image desired material/focus point). 

In all the above cases the rendered image is being interactively updated. After mouse release, 
Cinema4D viewport is automatically updated to current view. 
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For Interactive Rendering option, if a Presto 
engine is selected an additional table appears 
below the rendered image presenting 
information of the devices used for rendering, 
their frames per second, samples per pixel, 
memory used and total memory. 
For hiding this window you can go at Window 
menu of the Darkroom and unselect the Show 
Interactive Info option. 
Tip: you can define the devices used by Presto 
engines, by going to Plugins menu > Thea 
Render > Devices (see details at paragraph 6.5) 
or by the Devices panel at Render Settings 
window (see Figure 42).  

 
Figure 41: Presto Engines Info during Interactive 

Rendering 

 
Figure 42: Devices settings at Render Settings 

window 

 

 Render Status Bar (Area D) 6.1.4

At area D of the Darkroom, we can see the Render Status Bar. 
 

  
Figure 43: Render Status Bar 

This bar shows the main information on rendering process and helps us start/pause/stop it, save the 
rendered image or send it to Cinema4D Picture Viewer. 
In more detail: 

 
Figure 44: Send to 

Picture Viewer 

Send to Picture Viewr button sends the rendered image directly to Cinema4D 
picture viewer window. 

 
Figure 45: Save 

Image 

The Save button is used for saving the image with the given format – you need 
to include the desired extension along with the name (it can also be *.img.thea 
for saving the whole buffer or *.clm for Colimo project files). 
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Figure 46: Elapsed 

Time 

At this area user can get information on the time elapsed since Production 
rendering started. 

 
Figure 47: Refresh 

Image 

Refresh button is used for refreshing the image once a change at the Exposure, 
Filtering or Channels selection has been made.  

 
Figure 48: Phase 

info 

Phase info box shows the main information regarding rendering progress. For 
Interactive Rendering, the Rendering message appears while for Production 
Rendering the phase of the process (for example Building Environment, number 
of passes/samples etc.). 

 
Figure 49: Start IR 

 
Figure 50: Start PR 

Start button starts either the Interactive Rendering (IR), which allows seeing any 
movement, material change or light addition interactively (button is as seen in 
Figure 49), or in case of Production Rendering (PR), starts the rendering process 
(button is as seen in Figure 50). 

 
Figure 51: Pause 

 
Figure 52: Stop 

Pause and Stop buttons are used for pausing the rendering or stopping it and 
have the same functionality as those at the top right bar. 

 
Figure 53: Progress 

info 

For Production Rendering the Progress bar shows visually the progress of each 
rendering phase (for example for each render pass). 

 

 Display Options (Area E) 6.1.5

Below, at area E, all the available Display option such as Exposure, Filtering, Channels and 
Photometric Analysis options appear. They work in the same way as inside Thea Studio Darkroom, 
so for additional details please refer to Thea User Manual corresponding chapter. 

 
Figure 54: Darkroom Display options 
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 Network 6.2

 
Figure 55: Plugin 

Menu Options 

The Network (see Figure 55Error! Reference 
source not found.) command prompts for 
opening the Thea Network log window (see 
Figure 56) where once Thea starts as Server 
(and clients contribute to main rendering) the 
needed details are displayed here. 
 

 
Figure 56: Thea Network  

 Export to Thea 6.3

The Export (see Figure 55) command prompts for saving a Thea 
scene that you can open afterwards within Thea Studio. By 
selecting the Export option you are able to export your scene in 
scn.thea, pack.thea or xml format. A window opens that allows 
you to specify the scene name and location (see Figure 57). 
Note 1: export the scene is not possible while rendering. 
Note 2: at Preferences window (as will be described later) you can 
select the default extension for saving your scene and also 
enable/disable opening directly your scene after exporting it at 
Thea Darkroom or Viewport. 

 
Figure 57: Save Thea Scene 

window 

 

 Convert Materials 6.4

With this option you are able to convert the Cinema4D materials to the corresponding Thea 
Materials.  
After pressing the Convert Materials button, a dialogue box appears (see it in Figure 58) that allows 
you to define if you want to convert the selected or all the materials of your scene or simply cancel 
the procedure. After converting a material to a Thea one, from now on the Thea materials attributes 
will appear for editing the material.  
Note: Cinema4D materials are automatically read as Thea materials when rendering starts (even if 
you have not converted them) without affecting your materials settings and type. 

 
Figure 58: Convert Materials dialogue box 

  
Figure 59: Cinema4D materials and the converted 

Thea ones 
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 Devices 6.5

The Devices option, allows you to open the Select Devices 
window (see Figure 60). Here you can see a list with the 
GPU and CPU devices of your machine, which can be used 
by Presto engine. At this window, you can enable/disable a 
device, by clicking to the corresponding box, and 
increase/decrease its priority. At this window apart from 
the names of the existing devices, you can also see their 
cores, their memory and other useful information. 

 
Figure 60: Select Devices window 

 

 Update 6.6

The Update button opens the Install Updates window (as 
seen in Figure 61). 
At this window user can see the available plugin versions 
and resources and select which ones wants to install. 
For more details and explanation of the existing options of 
the Updates window, please refer to Thea User Manual. 

 
Figure 61: Thea Updates window 

 

 License 6.7

The License option, as we have already described, allows 
an easy activation of your license from within Cinema4D. 
The first time you want to activate the license, you need to 
add here your full name, email address, your serial number 
and at the Plugins tab the Cinema4D serial number as well, 
and then ask for an activation code. The system will send 
you back the activation code and after restarting your 
application, Thea will be registered. 
For more details on activation procedure please refer to 
Thea User Manual. 

 
Figure 62: License Input Form window 
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 Preferences 6.8

As we see in Figure 63 The Thea Preferences window helps 
you to define some special default values to make plugin 
use smoother. 
At Render Settings, you can select the engine that will be 
used by default for Production and Interactive Rendering. 
Additionally, at the Material Editor Options, you can define 
at first the default Material Room used for the material 
preview (Cloth for example). You can also enable the Auto 
Invoke Material Lab option that allows opening of Thea 
Material Lab with double-clicking on the material preview. 
This option is by default disabled and so double-clicking on 
the material preview opens the Cinema4D Material Editor 
window. Note that this change in order to be applied 
requires a restart of Cinema4D. 
With the Auto Refresh Material option, the material 
preview is automatically refreshed with any changes. 
Otherwise, one needs to press the Refresh button of the 
Thea Material Panel to see the new material preview (see 
Figure 64). 
At the Export Options area, you can specify the Default 
Extension for saving a Thea scene (scn.thea, pack.thea or 
xml) and also enable/disable the automatic opening of the 
scene either at Thea Studio (Viewport) or Darkroom. 
 

 
Figure 63: Preferences window 

 
Figure 64: Refresh Material button 

 About 6.9

The last option found at this menu is the About. This 
submenu opens a window that gives you some main 
information for the plugin, such as its current version. 

 
Figure 65: About Thea Render window 
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 THEA RENDER SETTINGS WINDOW 7.

 
Figure 66: Thea Render Settings window 

 
Tip: with the button Clean Videopost we can 
remove unnecessary time consuming effects / 
settings, computed by Cinema4D during 
rendering initialization (like Sketch or Toon). 

As we have already said, by going to Render > Edit 
Render Settings we can select Thea Render among 
the existing renderers. At the right side of the 
window the available settings panels appear (see 
Figure 66): General and Baking. The settings inside 
Render Settings window and inside Darkroom 
window are linked, and a change to one option is 
changing the corresponding option to the other 
window too. 
 
Tip: with the button “Render Setting…” at the 
bottom, by selecting the New option, you can 
create and save the needed render presets, for 
faster selection at the Render menu. 
 
At the next tables we see the options that exist at 
each panel and their main functionality. Please 
refer to Thea manual for the parameterization and 
more detailed explanation of the existing settings. 

 

 General 7.1

At the General Panel, at Mode, user can select 
among the Interactive and the Production Mode 
in order to adjust engine settings for these two 
cases (see Figure 69). 

 
Figure 67: Production Mode tab 
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 Interactive Mode 7.2

 
Figure 68: Interactive Mode Settings 

With Interactive Mode selected the settings as see in Figure 
66 are appearing. 
At Main panel, user can define at first the engine that will 
be used for rendering (Presto AO, Presto MC or Adaptive 
AMC) and below adjust the corresponding settings that 
appear per engine. For example, for all engines user can 
define the Tracing Depth, enable/disable Displacement and 
Motion Blur, for Presto AO there is also the option to 
enable or disable Ambient Occlusion and define its 
Distance and Intensity, and for Adaptive AMC, the Adaptive 
Bias percentage can be also specified. 
For Presto engines, the Devices options also appear, in 
order to define the use of only GPU devices, or only CPU or 
both for rendering and set priorities for each one of them. 
 

 
 

 Production Mode 7.3

Once the Production Mode option is selected (see 
Figure 69) all the needed settings for the final 
rendering appear within the General tab. Note that a 
new tab named Channels appears now on top. 
 
At the Presets list, you can select among the available 
presets and use its settings of the final rendering. Note 
that by selecting a preset and press the Apply Preset 
button it actually overrides all the other settings. By 
selecting the Manual option, the settings as defined 
manually will be used for rendering. 
At the Main panel, user can select for rendering 
among the available render engines: Adaptive BSD, 
Unbiased TR1, Unbiased TR2, Presto AO, Presto MC or 
Adaptive AMC.  
 
Several other options exist to enable/disable at this 
tab, depending once again on the engine that is used 
for rendering. You can enable for example relight, 
displacement and repaint options. At Termination you 
can define time or samples/pixel limits for the 
progressive engines. 
 

 
Figure 69: Production Mode tab 

For the case of the Adaptive BSD engine two extra tabs appear on top that help you edit Ray Tracing 
and Global Illumination Settings (see the next figures).  
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These tabs, Biased RT (Ray Tracing) and Biased GI (Global Illumination) show all the needed settings 
for the Adaptive BSD engine so that all the necessary adjustments can be made. 
At the Biased Ray Tracing panel, you can specify the Antialiasing options, enable Clay Render and 
adjust any settings related to Blurred Reflections, Ambient Occlusion and Termination Criteria. 
At the Biased Global Illumination panel, you can enable Field Mapping technique, Caustics, Final 
Gathering and adjust the needed Irradiance Cache settings. 
For more detailed explanation of these settings please refer to Thea User Manual and Adaptive 
(BSD) engine pdf tutorial. 

 
Figure 70: Biased RT Panel 

  
Figure 71: Biased GI Panel 

Tip: by pressing the on the Advanced option triangle button, a new menu appears with more 
advanced settings. In this way you can show/hide the needed/unneeded panels. 
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 Thea Channels – Multi Pass Option 7.4

At the Channels tab, a list with all available 
channels (depending on the engine that we have 
selected) appears (see Figure 73).  
For cases of a single frame rendering, you will be 
able to see the rendered channels inside 
Darkroom, at the Channels list (see   
Figure 72). 
 

   
Figure 72: Channels inside Thea Darkroom 

window 

 
Figure 73: Channels Tab 

 
 
 

As we will also mention later, for rendering 
animations one needs to use Cinema4D Picture 
Viewer (with Thea Render engine enabled). For 
cases we need to render multiple channels 
during an animation, we need to enable apart 
from the render channels in Channels tab, the 
Multi-Pass option (see Figure 74). 
At the Save menu, the Multi-Pass image options 
will appear to let you define the path of saved 
channels and their format. 
In this way Thea can be used for rendering 
animations along with their rendered channels.  

Figure 74: Multi-Pass enabled 
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 Baking 7.5

 
Figure 75: Baking tab 

 

 
Figure 76: Baking Modes 

 

 
Figure 77: Thea Bake tag 

At the Baking panel, user can select to enable, 
disable or disable by default texture baking for the 
selected scene. 
 
By enabling Baking, all textures will be baked, 
according to Normal and High resolution given 
below, except if specified differently by a Thea tag 
for baking (as we will describe later, at the Thea 
Tags section). Normal resolution affects all kind of 
channels textures while High resolution those used 
for bumping and background. Note that according 
to these resolution settings (if values are quite big, 
a delay before rendering starts may occur). 
By selecting to disable baking, no textures will be 
baked at all. 
The next option, Disable by Default, will disable 
baking, except if one adds a special baking tag to a 
certain object, where baking is enabled (see Figure 
77). In this way, texture baking will be generally 
disabled, but enabled for the tagged objects only. 

 
 
 
 

 CINEMA4D MATERIALS (NATIVE) 8.

Cinema4D materials are automatically converted to Thea materials when rendering begins (without 
affecting your materials inside Cinema4D). There are special heuristics that are used in the 
conversion process; nevertheless, the result may look quite different from how the material looks 
using Cineam4D internal renderer. 
With the Convert Materials (as we saw previously) you are able to convert the Cinema4D materials to 
the corresponding Thea ones for allowing editing with the Thea Materials settings. 
Other materials (from other plugins) are not supported. In this case, Thea will render them black. 
Cinema4D (procedural) shaders are supported only through texture baking. Texture baking can be 
controlled using Thea Render settings and Thea Bake tag. 
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 THEA MATERIALS 9.

Thea for Cinema4D can make full use of Thea Material Lab but also allows editing of materials from 
within Cinema4D. With the use of the Material Library you can also simply drag and drop a Thea 
material at your model. At the next paragraphs, we will see the available ways to create, edit and use 
a Thea Material inside Cinema4D. 

 Editing a Thea Material within Cinema4D Material Editor 9.1

The first step is to create a Thea Material. 
For this you have to follow one of the 
following ways: 
Version R12: Top Menu > File > Thea 
Material (or from the Materials window) 
Version R13: Top Menu > File > Shader > 
Thea Material (or from the Materials 
window) 
Version R14 and R15: Top Menu > 
Create > Material > Thea Material or at   
the Materials window Create > Shader > 
Thea Material (see Figure 78). 
The material created in these ways, will 
be initially a white basic material and will 
be added at the Materials window (see 
Figure 79). 

 
Figure 78: Create a Thea 

Material 

 
Figure 79: Thea Material 

(initially) 

Another way to create a Thea material is the conversion of the Cinema4D material to the 
corresponding Thea material, with the use of the Convert Materials button. 
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After creating the material, it is possible to edit it inside 
Cinema4D. By clicking once on the material the custom 
material editor for Thea materials inside Cinema4D appears 
at the Attributes panel (see Figure 81). This editor is a 
simplification of the standard Thea material lab. Here you 
can edit a material that has at most two or three 
components of the same type: at most 3 coatings, 3 glossy, 
3 basic substrates, or 2 thin films, 2 SSS substrates. Initially, 
the empty material comes with the General and Matte 
components.  
Below we see what options exist at each tab. 
 
Tip: By enabling a component, the corresponding tab also 
appears where the component available settings exist. 
 
 
Note 1: below the material preview window, two extra 
buttons for Refreshing the preview (in case Auto Refresh at 
Preferences is disabled) and for opening the material inside 
Thea Material Lab exist (Figure 80). 

 
Figure 80: Refresh and Material Lab buttons 

 
Note 2: for more details on Thea materials and their 
settings, please refer to Thea User Manual, at the Material 
Lab chapter.  
 

 
Figure 81: Thea Material Settings 

(Attributes panel) 

Please note that material parameters shown are depended on the selected engine. This means that - 
for example - if Presto is enabled, only the parameters used in Presto will be shown (so, any 
unrelated parameter will be hidden). 

At the Basic tab you are able to add/remove components to 
the material (as we said the maximum is 3 or 2 components 
of each type). At our example, as seen in Figure 82, we have 
enabled the Matte and Thin Film components. 
We see that the Thin Film tab also appears on top tabs list. 
 
 

 
Figure 82: Basic information 
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At the General panel you can edit some basic material 
settings (such as Repaintable, Tracing Depth etc.) and you 
can also alter the material room used for the material 
preview and its quality (passes). 
 

 
Figure 83: General Panel 

Tip: with Shift + Click on the wanted tabs, we can enable and 
see more than one panel at the same time, one below the 
other. As we see in Figure 84, we can have all the needed 
settings for the Matte and Thin Film components available. 
Their Scattering, Structure, Layer, etc. panels with their 
corresponding settings each, are all visible. 
 
Note: Matte, Thin Film, SSS (Subsurface Scattering), Glossy 
and Coating are the five basic Thea Materials components. 
Each comes with different set of special settings, which are 
presented at the corresponding panels. 
 

 
Figure 84: Matte and Thin Film panels 

At the Description panel we can see and add a description 
for the Thea material and at the Assign tab we can see on 
which model(s) the material is applied. 

 
Figure 85: Description and Assign panels 
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By double clicking on the material preview (inside the 
Materials panel) the Material Editor window opens as seen 
in Figure 86 (floating dialogue window). 
In the same way as we have described above, we can adjust 
here material components and layers, and once we click on 
each layer, see all the available settings appearing at the 
right side of the window.  
 
 
Note: in case the option “Auto Invoice Material Lab” at the 
Preferences panel is enabled, Thea Material Lab will open 
instead of Cinema4D Material Editor. 
 

 
Figure 86: Material Editor 

 
 

 Editing a Thea Material with the Thea Material Lab 9.2

 
Figure 87: Thea Material Lab 

Editing the material using Thea standard material lab is 
either possible by double clicking on the material icon 
(inside Materials window) in case the option “Auto 
Invoice Material Lab” at the Preferences panel is 
enabled or by pressing the button Material Lab that 
can be found below the material preview. 
 
Either of these ways will employ Thea Material Lab as 
an external application and Cinema4D will freeze until 
you exit the application. The material will then refresh 
with the changes that you have made in the material 
lab. 
Accept or close button apply any changes made inside 
Thea Material lab while Reject button ignores the 
changes. 
 

 

 Adding a Thea Material from the Content Browser 9.3

As we have already mentioned, additionally to the plugin, you can download a material library with 
ready-to-use materials (please visit www.thearender.com/cinema4d for more details). 
After installing the library at the browser folder of Cinema4D, you can find the library inside the 
content browser (see Figure 88) or load the material from the materials window (Create > Load 

http://www.thearender.com/cinema4d
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Material Preset > Thea Materials – see Figure 89). 
Tip 1: as we have already mentioned, if you face problems to locate the correct folder where 
Cinema4d stores its material libraries (lib4d format) you can find the correct path by going to Edit > 
Preferences and see that path at the bottom. At this location, inside the “library” folder, you can find 
the “browser” folder where the Thea Library needs to be added. 

  
Figure 88: drag and drop a material from the 

content browser to your model 

 
Figure 89: Thea Libraries can be accessed too from 

the Materials window 

 
 
 

  LIGHTS 10.

Cinema4D point lights are automatically supported by 
converting them to the corresponding Thea point light. 
The area lights are also being supported and are always 
emitting light following inverse square law (note: at the 
moment, only the following types are supported: Area, 
Disc, Rectangle, Sphere, Cylinder, Cylinder and   
Perpendicular). If you want to use a Thea custom area 
emitter though, you should create it as a Thea material 
and assign this like a normal material to a model.  

 
Figure 90: dragging a light with a Thea Sun 

tag changes Thea sun position 

Besides the point lights, Sky is also being supported enabling automatically Thea physical sky (by 
adding the Thea Sky tag on a Cinema4D sky). There is also the custom Thea Sun tag that we will see 
analytically later, which you can assign to any point light; in this way you can adjust Thea sun-sky 
easily by dragging this  common point light around the scene. With the use of Thea light tag, which 
you can add to any Cinema4D light, you can override its settings and make it behave like a Thea point 
light (see more details to Thea Tags section). 

 

  ANIMATION 11.

Thea Render can support animation from Cinema4D by rendering the desired key frames of the 
animation bar. After setting up your animation you can go and select as render engine Thea Render 
(at Render Settings), then at Output panel define the needed frames that will be rendered (see Figure 
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92). At the Save panel, specify also the Output folder, where the rendered image sequence will be 
saved (see Figure 93). If channels need to be rendered, enable the Multi-Pass option and define path 
for saving too 
 
Important Note: currently, for animations, you need to start your rendering from the Picture Viewer 
of Cinema4D, as Thea Darkroom will only render the current frame. 

 
Figure 91: setting up the 

animation 

 
Figure 92: select the desired 

frames 

 
Figure 93: define the output 

folders 

 
 
 
 
 

  TEAM RENDER SUPPORT 12.

Thea Render can be also used by the Team 
Render of Cinema4D which allows using other 
machines for network rendering. You only need to 
setup Team Render as always (enable it, run 
clients and add machines). Select Thea Render as 
render engine and start rendering with Team 
Render at the Team Viewer. The rendering of the 
frames will be split among the server and the 
clients. Thea client or Studio should be enabled to 
the client machines as well. Note that co-
operative rendering on the same frame using 
Team Render is not yet supported; currently, you 
can only use Thea Render network rendering for 
co-operative rendering on still images and not 
Team Render. 
 
Important Note: for allowing Team Render to set 
up the network rendering and not Thea server 
itself, at the Network settings of Thea (see 
Distribution at General panel) Network should be 
set to None to avoid any network conflicts. 

 
Figure 94: Frames rendering is split to server and 

client 
 

 
Figure 95: Thea Server is disabled (Network set to 

None) when Team Render needs to be used 
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  THEA RENDER TAGS 13.

Thea Render gives you the possibility to add some additional 
tags to the Cinema4D objects. These are the following: Thea 
Bake, Thea Camera, Thea Light, Thea Sky and Thea Sun. At the 
following tables we analyze each of these tags. 
 
As seen in Figure 97 each tag can be applied to a Cinema4D 
object and give it specific Thea features. 
 
Tip: Cinema4D Composition tag is also partially supported. The 
options Cast Shadows, Receive Shadows (only for Adaptive BSD 
engine) and Seen by Camera options are supported by Thea. 
 
Note: for more detailed explanation of Thea Cameras and Lights 
settings, please refer to Thea manual. 

 
Figure 96: Thea Render Tags 

 
Figure 97: Thea Tags; Sun, Camera, 

Light and Bake 

 Thea Bake Tag 13.1

As we have already mentioned at the Preferences Settings 
window, texture baking can be either enabled to the scene by 
default, be disabled or be disabled by default. With this tab, the 
enable and disable by default options can be overridden to the 
selected materials. 
For the certain material, there is the option to enable baking, 
disable it or leave the default option (which follows the hierarchy 
selection of the option or general settings). 
Below, there is the option to select different resolutions and 
override the default ones by checking the corresponding box. 

 
Figure 98: Thea Bake tag 

 Thea Camera Tag 13.2

The next tag that we can use is the Camera tag. 
This tag can be added at a Cinema4D camera and 
allow usage of Thea Camera settings for it (if the 
option Override C4D Physical Camera is enabled). 
 
By enabling the Override Thea Display option, 
some different settings than the general ones can 
be set for this selected camera. This means that 
once this camera is used, at Darkroom, Display 
options will be changed. Animation of these 
settings is also available; this allows easy camera 
display settings change and adaption, during an 
animation, where lighting conditions may change. 

 
Figure 99: Thea Camera tag 
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 Thea Light Tag 13.3

 
Figure 100: Thea Light Tag 

 

Thea Light tag can be added at a 
Cinema4D light and make it 
behave light a Thea point or area 
light (if the Override C4D Point 
Light option is enabled).  
At the Type drop down list we can 
select to change the Thea Light 
type among Omni, Spot, IES, 
Projector or Area. This allows easy 
change of the lights type without 
the need to re insert it. 
 
For each selection the 
corresponding options appear 
which allow you to control each 
light settings (see figures at the 
right-side). 

 
Figure 101: Omni Light Settings 

 
Figure 102: Spot Light Settings 

 
Figure 103: IES Light Settings 

 
Figure 104: Projector Settings 

 
Figure 105: Area Light Settings 

 
 

 Thea Sky Tag – Setting Up Environment (Sky and IBL) 13.4

Thea Sky tag can be added to Cinema4D Physical Sky. As seen in 
Figure 106, Thea Sky tag is added as an extra tab and gives user 
the possibility to add and edit Thea Sun, Thea Sky and Image 
Based Lighting Illumination. 

 
Figure 106: Thea Sky Tag 
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At the General tab, at Illumination drop down list user can select 
to enable Sun+Sky option, IBL, Sky Only or IBL+Sun for the scene. 
 
Note: in case a Thea sun tag is added to any light source of the 
scene, the sun position coordinates defined at this tab (see 
Physical Sky tab – Sun Position in Figure 108) will be ignored. 
 
 

 
Figure 107: Illumination Drop Down 

List 

Depending on this selection, extra tabs appear with the corresponding set of settings. User can 
define here Sky and Sun properties (see Figure 108) as well as load a map for Image Based Lighting 
(see Figure 109). In case both Sun and IBL are enabled, both tabs will appear (see Figure 111). 

 
Figure 108: Sun + Sky 
Option – Physical Sky 

tab 

 
Figure 109: IBL Option – 
Image Based Lighting tab 

 
Figure 110: Sky Only 

Option – Physical Sky tab 
 

Figure 111: IBL + Sun 
Option: Physical Sky and 

Image Based Lighting 
tabs 

 

If user needs to have different maps for Background, Reflections and Refractions, the options 
appearing at the General tab (Background Mapping, Reflection and Refraction Mapping) need to be 
enabled too. This will open the additional tabs with map settings (see Figure 112, Figure 113 and 
Figure 114). By enabling Global Medium the corresponding tab with Medium options appears too 
(see Figure 115). 

 
Figure 112: Background 

Mapping tab 

 
Figure 113: Reflection 

Mapping tab 

 
Figure 114: Refraction 

Mapping tab 

 
Figure 115: Global 

Medium tab 
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 Thea Sun Tag 13.5

The last tag, Thea Sun, can be added to any Cinema4D light 
source and make it behave like Thea Sun. In this way Thea sun 
position can change by dragging the light source accordingly.  
In case Manual Sun is selected, more settings appear as seen 
inFigure 116, that allow to specify parameters for the sun like its 
color, power and attenuation.  
Note that if this tag is added to any light in the scene, Sun 
position defined at the Sky tag will be ignored and only this one 
will be taken into account. 
 

 
Figure 116: Thea Sun Tag 

 

Figure 117: Manual Sun enabled 

 

 
 
For more plugin details, download links and resources please visit  
http://www.thearender.com/cinema4d 

Image by George Drakakis 
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